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1.0 Introduction 
This guide provides the Clinical Application Coordinator (CAC) tools necessary to 
optimize the Electronic Health Record (EHR) Graphical User Interface (GUI) for 
Blood Pressure Management (Million Hearts). Sites may choose to deploy one, some, 
or all optimizations offered. 

The toolkit includes new Clinical Reminders and Text Integration Utility (TIU) 
templates for the Integrated Problem List (IPL) care planning feature. Step by step 
instructions for numerous optimizations are included. 

Population management is supported in iCare and via Reminder Reports. 
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2.0 Overview of Configuration Steps 

2.1 Essential options 
Option Configuration 
1 Create Hypertension Management order menu and add to Medication menu(s) 

(Section 3.0) 

2 Add IHS Hypertension Management algorithm to EHR (Section 4.0) 

3 Configure iCare panels (Section 10.2) 

4 Install, test and deploy IHS-MH Hypertension Control 2015 reminder tools * 
(Section 8.0) 
* currently deployed Clinical Reminder sites 
 requires options 8 and 9 

2.2 Additional options 
Option Configuration 

5 Install IHS-MH Hypertension 2015 Recall reminder 
*** used as reminder report (Section 10.1) 

6 Set up Public Views for Graphing tool (Section 5.0) 

7 Set up Lab Worksheets (Section 6.0) 

8 Create Indian Health Service (IHS) Flowsheets and Measurement Panels 
(Section 7.0) 

9 Create VA Health Summaries and TIU Objects (HYPERTENSION CONTROL) 
from flowsheets and measurement panels (Section 7.4) 

10 Create Health Summary Button (Section 7.4.3) 

11 Configure IPL with TIU Templates for IPL Goals, Care Plans and Visit 
Instructions (Section 9.0) 
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3.0 Order Menus 
• Order menu may be developed to support Hypertension Management Protocol. 

• Organize by Therapeutic Lifestyle Interventions, First Line Medications, 
Additional Medications, Lab Monitoring. 

• Within groups, provide organization by drug class. 

• Add to Medication Menus. 

• Refer to the EHR CAC Setup Guide v1.1 for instructions on how to build quick 
orders and menus (http://www.ihs.gov/ehr/index.cfm?module=cac). 

 
Figure 3-1: Sample Hypertension Management order menu 

http://www.ihs.gov/ehr/index.cfm?module=cac
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4.0 Add Hypertension Web Links to EHR 
You may add a web page that defaults to the IHS Hypertension Protocol and the IHS 
National Pharmacy and Therapeutics Committee resources. 

4.1 Design Mode Configuration 
Refer to the EHR CAC Setup Guide v1.1 for details on how to use Design Mode 
(http://www.ihs.gov/ehr/index.cfm?module=cac). 

4.2 Add a Web Page to a Tab 
1. In Design mode, select the tab in which to place the algorithm. It may be in a tree 

node or group bar placed on a tab. In the following example, a group was added to 
a group bar. 

 
Figure 4-1: Adding an item to a Group Bar 

http://www.ihs.gov/ehr/index.cfm?module=cac


EHR Optimization for Million Hearts Blood Pressure Management 

User Guide Add Hypertension Web Links to EHR 
November 2015 

5 

 
Figure 4-2: Adding Internet Explorer object to EHR Template 

2. Add the Internet Explorer object to the group selection. 

 
Figure 4-3: Adding the default URL to the HOMEPAGE field 

3. Edit the properties of the Internet Explorer object. 
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4. Place the following URL in the HOMEPAGE field: 
http://www.ihs.gov/MedicalPrograms/Diabetes/HomeDocs/Tools/Algorithms/HT
N_MGT_Algorithm_508c.pdf 

The selection defaults to the IHS Hypertension Management algorithm. 

 
Figure 4-4: IHS Hypertension Management Protocol displayed in EHR 

5. Repeat Steps 1 through 4 to add an option for NPTC Resources, placing the 
following link in the Homepage field: 

http://www.ihs.gov/NPTC/index.cfm?module=dsp_nptc_resources 

http://www.ihs.gov/MedicalPrograms/Diabetes/HomeDocs/Tools/Algorithms/HTN_MGT_Algorithm_508c.pdf
http://www.ihs.gov/MedicalPrograms/Diabetes/HomeDocs/Tools/Algorithms/HTN_MGT_Algorithm_508c.pdf
http://www.ihs.gov/NPTC/index.cfm?module=dsp_nptc_resources
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Figure 4-5: National Pharmacy & Therapeutics Committee Resources displayed in EHR 

4.3 Add a Web Page using the Program Launcher Button 
To configure a program launcher button to add a web page: 

1. Select the location at which to add access to a web page. 

 
Figure 4-6: Add an Object dialog; adding Program Launcher button 
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2. In Design Mode, add the Program Launcher object. 

3. Edit the properties for a specific web page to launch. 

Property Value 
Align Usually aligned right or left 

Anchors Top, left, bottom 

Caption (button name) HTN Protocol 

Command line  Web URL you want to launch 

EXE name Launches search, look in program files and select 
iexplore application 

 

 
Figure 4-7: Properties for Program Launcher dialog 

4. Click Apply to save. 

5. Click OK to exit. A button is displayed on the toolbar (Figure 4-8) that when 
clicked will launch a web page in a new window. 

 
Figure 4-8: Program Launcher button on Toolbar 
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4.4 Save Template Settings in Design Mode 
To save template settings and exit design mode: 

 
Figure 4-9: Design menu 

1. Select Save as Template from the Design menu. The Save As Template dialog 
(Figure 4-10) is displayed. 

 
Figure 4-10: Save As Template dialog 

2. Select the Template name. 

3. Click Save. 
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5.0 Graphing 
Graphing includes the ability to view multiple data types on one graph. Users may 
also view each data type in separate graphs. Graph views which contain one or more 
types of data may be saved and shared among users. 

5.1 Configuration 
Set ORWG GRAPH PUBLIC EDITOR CLASS parameter 

The ORWG GRAPH PUBLIC EDITOR CLASS is the parameter that enables a class 
(usually the CLINICAL COORDINATOR class) to define Public views. Once this 
has been set up, the CAC can create default public settings and perhaps several views 
for the users. 

The CAC can set up a public view for one or more Hypertension views. 

See Section 6 of EHR p11 patch guide for details on Graphing configuration and use. 

http://www.ihs.gov/RPMS/PackageDocs/EHR/ehr_0110.11o.pdf 

See also Help contents in EHR. The graphing information is listed under the Reports 
and Lab Results help sections 

 
Figure 5-1: Graphing Help 

5.2 Graph Views 
1. Click the Select/Define button to display the Select Items and Define Views 

dialog (Figure 5-2). 

http://www.ihs.gov/RPMS/PackageDocs/EHR/ehr_0110.11o.pdf
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Figure 5-2: Select Items and Define Views dialog 

2. Make the necessary selections in the various fields of the dialog. 

3. Do one of the following: 

• Click Save Personal to save this view as a personal view. 

• Click Save Public to save this as a public view (if authorized). The Save this 
Public View dialog (Figure 5-3) is displayed. 

 
Figure 5-3: Save this Public View dialog 

– Type the name of the public view. 
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– Click OK. The new view is now available on the graphing tool. 

 
Figure 5-4: Graph Personal and Public Views 

Figure 5-5 shows is a very data dense graph. 

 
Figure 5-5: Graph example 1 
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Optionally, display fewer data points in a different graph by creating a different view: 

 
Figure 5-6: Select Items and Define Views dialog for brief hypertension 

Note a less cluttered graph: 

 
Figure 5-7: Graph example 2 
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Display details of the graphed data. Click on the graph legend to display a summary 
of the contents of the graph (Figure 5-8). 

 
Figure 5-8: Selected Items from Graph example 2 
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Click the medication legend to display medication detail: 

 
Figure 5-9: Selected Items from Graph example 2 

Display individual graphs: 

 
Figure 5-10: Individual graph display 
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6.0 Lab Worksheets 
The lab worksheet tool provides the ability to display up to seven labs for a selected 
period of time for quick review of a patient’s condition. It is possible to select and 
display another user’s worksheets. 

Note: The CAC can create the worksheet and users may use the 
persons with defined Test Groups dropdown to select the 
CACs name, select the group they want to use. 

1. Select Worksheet from the Lab Results list (Figure 6-1). 

 
Figure 6-1: Lab Results list 



EHR Optimization for Million Hearts Blood Pressure Management 

User Guide Lab Worksheets 
November 2015 

17 

 
Figure 6-2: Select Lab Tests dialog 

2. To select labs for the worksheet: 

a. Click to highlight each lab wanted in the Laboratory Tests pane. 

b. Click Add to add the selected test to the Test to be displayed pane. 

3. Click NEW. 

 
Figure 6-3: Confirmation dialog 

4. Click Yes. Note that the group is available to display (Figure 6-4). 
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Figure 6-4: Select Lab Tests dialog 

The worksheet is displayed in a grid format and may be expanded or limited by 
timeframes: 

 
Figure 6-5: Worksheet display 
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7.0 IHS and VA Health Summary tools 
VA Health Summary Components package (BHS) allows the CAC to build brief 
health summaries and uses these as reports or as TIU objects. The Flowsheets 
component and Measurement Panels component in the VA Health Summary allow 
the use of the IHS Health Summary Flowsheets and Measurement Panel to create 
reports and objects. 

Tip: The Resource and Patient Management System (RPMS) 
Master Configuration menus for reports are cumbersome to 
navigate recommend site manager assigns the CAC the IHS 
and VA health summary maintenance menus: 
IHS Health Summary Maintenance Menu 
 IHS Health Summary Maintenance Menu 
 [APCHSMAINT] 
VA Health Summary Maintenance Menu 
 Health Summary Maintenance Menu [GMTS 
 IRM/ADPAC MENU] 

7.1 Create Measurement Panels in IHS Health Summary 
The CAC can use this functionality to create measurement panels to display recurrent 
data for a set period of time or set number of occurrences. You can combine these 
into a report or TIU object using the VA Health Summary Components and TIU 
applications. The display is limited to 25 characters per item in width before it wraps. 
It’s advisable to limit it to approximately 70 characters in width for optimal display in 
TIU Notes. 

Create a Measurement Panel 
At the “Select Health Summary Maintenance Option” prompt [APCHSMAINT], 
select MM (Create/Modify Measurement Panel). 

                     ************************************* 
                     **        IHS Health Summary       ** 
                     ** Health Summary Maintenance Menu ** 
                     ************************************* 
                           IHS PCC Suite Version 2.0 
 
                               2011 DEMO HOSPITAL 
 
   IS     Inquire About a Health Summary Type 
   HM     Health Maintenance Reminders ... 
   PP     Print Health Maintenance Item Protocols 
   LS     List Health Summary Types 
   LC     List Health Summary Components 
   LM     List Measurement Panel Types 
   LF     List Health Summary Flowsheets 
   LI     List Health Summary Flowsheet Items 
   MS     Create/Modify Health Summary Type 



EHR Optimization for Million Hearts Blood Pressure Management 

User Guide IHS and VA Health Summary tools 
November 2015 

20 

   MM     Create/Modify Measurement Panel 
   MF     Create/Modify Flowsheet 
   MI     Create/Modify Flowsheet Item 
   DS     Delete Health Summary Type 
   DM     Delete Measurement Panel Definition 
   DF     Delete Health Summary Flowsheet 
   DI     Delete Health Summary Flowsheet Item 
   HS     Generate Health Summary 
   BP     Best Practice Prompt Menu ... 
   FMMT   Create/Modify Health Summary Type using Fileman 
   HSSP   Update Health Summary Site parameters 
   IPT    Update the Minor Procedures CPT Taxonomy 
   MPT    Update the Major Procedures CPT Taxonomy 
   PWH    Patient Wellness Handout Menu ... 
 
Select Health Summary Maintenance Option: mm  Create/Modify Measurement 
Panel 
 
Select HEALTH SUMMARY MEAS PANEL NAME: Hypertension Measurements 
  Are you adding 'Hypertension Measurements' as 
    a new HEALTH SUMMARY MEAS PANEL (the 8TH)? No// Y  (Yes) 
NAME: Hypertension Measurements  Replace 
Select ORDER IN PANEL: 5 
   ORDER IN PANEL PANEL COMPONENT: BP 
     1   BP       BLOOD PRESSURE 
     2   BPF       BEST PEAK FLOW 
CHOOSE 1-2: 1  BP     BLOOD PRESSURE 
  PANEL COMPONENT: BP// 
  FIELD WIDTH: 8 
  LABEL: BP 
  TRANSFORM: 
  NOTE TO DISPLAY: 
Select ORDER IN PANEL: 10 
   ORDER IN PANEL PANEL COMPONENT: WT       WEIGHT 
  PANEL COMPONENT: WT// 
  FIELD WIDTH: 8 
  LABEL: Weight 
  TRANSFORM: 
  NOTE TO DISPLAY: 
Select ORDER IN PANEL: 15 
   ORDER IN PANEL PANEL COMPONENT: PU       PULSE 
  PANEL COMPONENT: PU// 
  FIELD WIDTH: 8 
  LABEL: Pulse 
  TRANSFORM: 
  NOTE TO DISPLAY: 
Select ORDER IN PANEL: 
 
Select HEALTH SUMMARY MEAS PANEL NAME: 



EHR Optimization for Million Hearts Blood Pressure Management 

User Guide IHS and VA Health Summary tools 
November 2015 

21 

7.2 Create Flowsheets in IHS Health Summary 
The CAC can use this functionality to create a flowsheet to display recurrent data for 
a set period of time or number of occurrences. Make several small flowsheets and 
combine them into a report or TIU object using the VA Health Summary Components 
and TIU applications. The display is limited to 25 characters per item in width before 
it wraps. It’s advisable to limit it to approximately 70 characters in width for optimal 
display in TIU Notes. 

For hypertension management, it may be helpful to create a Flowsheet to display labs 
and combine with the Measurement Panel for use in a health summary report and/or 
TIU object. 

Create a Flowsheet 
At the “Select Health Summary Maintenance Option” prompt [APCHSMAINT], 
select MF (Create/Modify Flowsheet). 

                        ************************************* 
                     **        IHS Health Summary       ** 
                     ** Health Summary Maintenance Menu ** 
                     ************************************* 
                           IHS PCC Suite Version 2.0 
 
                               2011 DEMO HOSPITAL 
IS     Inquire About a Health Summary Type 
   HM     Health Maintenance Reminders ... 
   PP     Print Health Maintenance Item Protocols 
   LS     List Health Summary Types 
   LC     List Health Summary Components 
   LM     List Measurement Panel Types 
   LF     List Health Summary Flowsheets 
   LI     List Health Summary Flowsheet Items 
   MS     Create/Modify Health Summary Type 
   MM     Create/Modify Measurement Panel 
   MF     Create/Modify Flowsheet 
   MI     Create/Modify Flowsheet Item 
   DS     Delete Health Summary Type 
   DM     Delete Measurement Panel Definition 
   DF     Delete Health Summary Flowsheet 
   DI     Delete Health Summary Flowsheet Item 
   HS     Generate Health Summary 
   BP     Best Practice Prompt Menu ... 
   FMMT   Create/Modify Health Summary Type using Fileman 
   HSSP   Update Health Summary Site parameters 
   IPT    Update the Minor Procedures CPT Taxonomy 
   MPT    Update the Major Procedures CPT Taxonomy 
   PWH    Patient Wellness Handout Menu ... 
 
Select Health Summary Maintenance Option: MF  Create/Modify Flowsheet 
 
Select HEALTH SUMMARY FLOWSHEET NAME: Hypertension Labs 
  Are you adding 'Hypertension Labs' as a new HEALTH SUMMARY FLOWSHEET (the 
11TH)? No// y  (Yes) 
NAME: Hypertension Labs// 
GENDER RESTRICTIONS: 
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LOWER AGE LIMIT: 
UPPER AGE LIMIT: 
Select ITEM ORDER: 1 
   ITEM ORDER ITEM TYPE: lab RESULT 
  ITEM TYPE: LAB RESULT// 
  ITEM LABEL: K+ 
  ITEM WIDTH: 7 
  TRANSFORM: 
  Select MEMBERS: LAB.POTASSIUM 
 
     Searching for a Lab test, (pointed-to by MEMBERS) 
 
     Searching for a Lab test 
  POTASSIUM 
        ...OK? Yes// y  (Yes) 
Select MEMBERS: 
  TRANSFORM 2: 
Select ITEM ORDER: 5 
   ITEM ORDER ITEM TYPE: lab RESULT 
  ITEM TYPE: LAB RESULT// 
  ITEM LABEL: Creat 
  ITEM WIDTH: 7 
  TRANSFORM: 
  Select MEMBERS: LAB.CREATININE 
 
     Searching for a Lab test, (pointed-to by MEMBERS) 
 
     Searching for a Lab test 
 
     1   CREATININE 
     2   CREATININE CLEARANCE 
     3   CREATININE SPOT URINE  SPOT URINE CREATININE 
     4   CREATININE, 24 HOUR URINE  _VMA CREAT UR 
     5   CREATININE, 24 HOUR URINE  _24UR CREAT (R) 
Press <RETURN> to see more, '^' to exit this list, OR 
CHOOSE 1-5: 1  CREATININE 
  Select MEMBERS: 
  TRANSFORM 2: 
Select ITEM ORDER: 10 
   ITEM ORDER ITEM TYPE: lab RESULT 
  ITEM TYPE: LAB RESULT// 
  ITEM LABEL: eGFR 
  ITEM WIDTH: 7 
  TRANSFORM: 
  Select MEMBERS: LAB.estimated gfr 
 
     Searching for a Lab test, (pointed-to by MEMBERS) 
 
     Searching for a Lab test 
  ESTIMATED GFR 
        ...OK? Yes// y  (Yes) 
  Select MEMBERS: 
  TRANSFORM 2: 
Select ITEM ORDER: 15 
   ITEM ORDER ITEM TYPE: lab RESULT 
  ITEM TYPE: LAB RESULT// 
  ITEM LABEL: Chol 
  ITEM WIDTH: 7 
  TRANSFORM: 
  Select MEMBERS: LAB.POC CHOL 
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     Searching for a Lab test 
  POC CHOLESTEROL 
        ...OK? Yes// y  (Yes) 
  Select MEMBERS: 
  TRANSFORM 2: 
Select ITEM ORDER: 20 
   ITEM ORDER ITEM TYPE: lab RESULT 
  ITEM TYPE: LAB RESULT// 
  ITEM LABEL: HDL 
  ITEM WIDTH: 7 
  TRANSFORM: 
  Select MEMBERS: LAB.POC HDL 
 
     Searching for a Lab test, (pointed-to by MEMBERS) 
 
     Searching for a Lab test 
  POC HDL 
        ...OK? Yes// y  (Yes) 
  Select MEMBERS: 
  TRANSFORM 2: 
Select ITEM ORDER: 25 
   ITEM ORDER ITEM TYPE: lab RESULT 
  ITEM TYPE: LAB RESULT// 
  ITEM LABEL: LDL 
  ITEM WIDTH: 7 
  TRANSFORM: 
  Select MEMBERS: LAB.POC LDL 
 
     Searching for a Lab test, (pointed-to by MEMBERS) 
 
     Searching for a Lab test 
  POC LDL 
        ...OK? Yes// y  (Yes) 
  Select MEMBERS: 
  TRANSFORM 2: 
Select ITEM ORDER: 30 
   ITEM ORDER ITEM TYPE: lab RESULT 
  ITEM TYPE: LAB RESULT// 
  ITEM LABEL: Trig 
  ITEM WIDTH: 7 
  TRANSFORM: 
  Select MEMBERS: LAB.POC TRIG 
 
     Searching for a Lab test, (pointed-to by MEMBERS) 
 
     Searching for a Lab test 
  POC TRIGLYCERIDE 
        ...OK? Yes// y  (Yes) 
    Select MEMBERS: 
  TRANSFORM 2: 
Select ITEM ORDER: 
Select EVOKING CODES: 
Select CLINIC DISPLAY RESTRICTIONS: 
 
Select HEALTH SUMMARY FLOWSHEET NAME: 
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7.3 View Flowsheets and Other Components 
These are created in the IHS Health Summary. Flowsheets and Measurement Panels 
can be displayed as part of an IHS Health Summary but are more often used to 
display in the Ad Hoc health. 

1. In EHR select the Reports tab. The Available Reports pane (Figure 7-1) is 
displayed. 

 
Figure 7-1: Available Reports pane 

2. Expand Health Summary and select Adhoc Report. The Ad Hoc Health 
Summary dialog (Figure 7-2) is displayed. 

 
Figure 7-2: Ad Hoc Health Summary dialog 



EHR Optimization for Million Hearts Blood Pressure Management 

User Guide IHS and VA Health Summary tools 
November 2015 

25 

3. Select Measurement Panels to launch the Measurement Panel dialog (Figure 
7-3). 

 
Figure 7-3: Measurement Panels dialog 

4. Select the Hypertension Measurements panel created in an earlier step. 

5. Click OK to return to the Ad Hoc Health Summary dialog (Figure 7-4). 

 
Figure 7-4: Ad Hoc Health Summary dialog 



EHR Optimization for Million Hearts Blood Pressure Management 

User Guide IHS and VA Health Summary tools 
November 2015 

26 

6. Select Flowsheet to launch the Flowsheet dialog (Figure 7-5). 

 
Figure 7-5: Flowsheet dialog 

7. Select the Hypertension Labs flowsheet created in an earlier step. 

8. Click OK to return to the Ad Hoc Heath summary dialog. 

9. Click OK to display the report (Figure 7-6). 

 
Figure 7-6: Measurement Panel Ad Hoc report example 

7.4 VA Health Summary for TIU object 
Use the VA Heath Summary Components to build a health summary. Use the health 
summary to create TIU objects. It is necessary to create a TIU Health Summary 
object to use in the IHS-MH Hypertension Control 2015 reminder dialog. 
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7.4.1 Create a VA Health Summary named Hypertension Control 
Use the VA Health Summary menu to create a new heath summary reports. 

Health Summary Maintenance Menu [GMTS IRM/ADPAC MENU] 

    1    Health Summary (Available with PCC only)  [ADEMHSOP] 
    2    Health Summary Configuration  [BEHORPHS MAIN] 
    3    Health Summary Coordinator's Menu  [GMTS COORDINATOR] 
    4    Health Summary Displaying CMS Register(s)  [APCHSUMR] 
    5    Health Summary Enhanced Menu  [GMTS ENHANCED USER] 
    6    Health Summary for Inactive Patient  [APCHSINA] 
    7    Health Summary Maintenance Menu [GMTS IRM/ADPAC MAINT MENU] 
    8    Health Summary Maintenance Menu  [BEHORPHS VHA MAINT MENU] 
    9    Health Summary Maintenance  [APCHSMAINT] 
    10   Health Summary Menu  [GMTS USER] 
    11   Health Summary Menu  [APCHMENU] 
    12   Health Summary Objects Menu  [GMTS OBJ MENU] 
    13   Health Summary Objects Menu  [BEHORPHS VHA OBJ MENU] 
    14   Health Summary Overall Menu  [GMTS MANAGER] 
 
Type '^' to stop, or choose a number from 1 to 14 :7  Health Summary 
Maintenance 
 Menu 
 
   1      Disable/Enable Health Summary Component 
   2      Create/Modify Health Summary Components 
   3      Edit Ad Hoc Health Summary Type 
   4      Rebuild Ad Hoc Health Summary Type 
   5      Resequence a Health Summary Type 
   6      Create/Modify Health Summary Type 
   7      Edit Health Summary Site Parameters 
   8      Health Summary Objects Menu ... 
   9      CPRS Reports Tab 'Health Summary Types List' Menu ... 
   10     CPRS Health Summary Display/Edit Site Defaults ... 
 
Select Health Summary Maintenance Menu Option: 6  Create/Modify Health 
Summary Type 
 
Select Health Summary Type: HYPERTENSION CONTROL 
 
Are you adding 'HYPERTENSION CONTROL' as 
    a new HEALTH SUMMARY TYPE (the 55th)?   No// y  YES 
NAME: HYPERTENSION CONTROL  Replace 
TITLE: 
SUPPRESS PRINT OF COMPONENTS WITHOUT DATA: 
LOCK: 
OWNER: RICHARDS,SUSAN P// 
 
Do you wish to copy COMPONENTS from an existing Health Summary Type? YES// 
n  NO 
Select COMPONENT: measurement panelS     MEAP 
SUMMARY ORDER: 5// 5 
OCCURRENCE LIMIT: 3 <<<< can use occurrence and/or time to limit display 
TIME LIMIT: 
HEADER NAME: Measurement Panels// 
 
file type <Prefix.?> 
 
Select SELECTION ITEM: Hy  <<< case sensitive, use the name of the 
measurement panel you made for hypertension 
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     Searching for a Measurement Panel, (pointed-to by SELECTION ITEM) 
 
     1   Hypertension Measurements 
     2   Hypertension Panel 
CHOOSE 1-2: 1  Hypertension Measurements 
Select SELECTION ITEM: 
Select COMPONENT: FLOWSHEET              FLO 
SUMMARY ORDER: 10// 10 
OCCURRENCE LIMIT: 3 <<<< can use occurrence and/or time to limit display 
TIME LIMIT: 
HEADER NAME: Flowsheet// 
 
No selection items chosen. 
 
Select new items one at a time in the sequence you want them displayed. 
You may select up to 3 items. 
 
Select SELECTION ITEM: Hyper 
 
     Searching for a Flowsheet, (pointed-to by SELECTION ITEM) 
 
     Searching for a Flowsheet 
 
     1   Hypertension Labs 
     2   Hypertension Monitoring 
     3   Hypertension measurements 
CHOOSE 1-3: 1  Hypertension Labs <<< case sensitive, use the name of the 
flowsheet you made for hypertension labs 
 
Select SELECTION ITEM: 
Select COMPONENT: 
 
Do you wish to review the Summary Type structure before continuing? NO// 
<<< Yes if you want to review your selections 
Please hold on while I resequence the summary order.. 

 
Figure 7-7: VA Health Summary detail 
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7.4.2 Create TIU Health Summary Object Hypertension Control 
Use the Create TIU/Health Summary Objects menu. 

                         Document Definitions (Manager) 
 
                               (2011 DEMO HOSPITAL) 
 
   DDM1   Edit Document Definitions 
   DDM2   Sort Document Definitions 
   DDM3   Create Document Definitions 
   DDM4   Create Objects 
   DDM5   List Object Descriptions 
   DDM6   Create TIU/Health Summary Objects 
   DDM7   Title Headers/Footers 
 
Select Health Summary Maintenance Menu Option: ^ddm6   Create TIU/Health 
Summary 
 
                              TIU Maintenance Menu 
 
                         Document Definitions (Manager) 
 
TIU Health Summary Object   Mar 30, 2015 14:15:14   Page:    1 of    2 
 
     TIU Object Name              Health Summary Type 
1    BRADEN SCALE 30D             No Health Summary Type Found 
2    CCL-PRENATAL                      CCL-PRENATAL FLOWSHEET 
+         Enter ?? for more actions 
Create New TIU Object               Find 
Detailed Display/Edit TIU Object  Detailed Display/Edit HS object 
    Quit 
 
                   --- Create TIU/Health Summary Object --- 
 
Enter a New TIU OBJECT NAME: HYPERTENSION CONTROL 
 
Object Name: HYPERTENSION CONTROL 
 
Is this correct? YES// y  YES 
 
Use a pre-existing Health Summary Object? NO// n  NO 
 
Checking HYPERTENSION CONTROL (TIU) with Health Summary... 
 
Creating Health Summary Object 'HYPERTENSION CONTROL (TIU)' 
 
 Select Health Summary Type: HYPERTENSION 
 
4 Health Summary Types found 
 
   1.  Hypertension Control 
   2.  Hypertension Management 
   3.  Hypertension Review 
   4.  Hypertension Monitoring 
 
Select 1-4:  1  HYPERTENSION CONTROL <<< enter the Health Summary you just 
created in the step above 
 
 Do you want to overwrite the TIME LIMITS in the Health 
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 Summary Type 'HYPERTENSION CONTROL'?  N// n  NO 
 
 Print standard Health Summary Header with the Object?  N// O 
 
 Partial Header: 
   Print Report Date?  N// O 
   Print Confidentiality Banner?  N// O 
   Print Report Header?  N// O 
   Print the standard Component Header?  Y// NO 
   Print the date a patient was deceased?  N// O 
 
 Print a LABEL before the Health Summary Object?  N// O 
 
 Suppress Components without Data?  N// O 
 
OBJECT DESCRIPTION: 
  No existing text 
  Edit? NO// 
 
Create a TIU Object named: HYPERTENSION CONTROL 
 
Ok? YES// 
 
TIU Object created successfully. 

7.4.3 Configure the Health Summary Button 
1. Identify the Internal Entry Number (IEN) for the Health Summary to display on a 

button in FileMan. Each site’s IEN for this Health Summary will be different. 

          VA FileMan Version 22.0 
          Enter or Edit File Entries 
          Print File Entries 
          Search File Entries 
          Modify File Attributes 
          Inquire to File Entries 
          Utility Functions ... 
          Data Dictionary Utilities ... 
          Transfer Entries 
          Other Options ... 
Select VA FileMan Option: inquire to File Entries 
OUTPUT FROM WHAT FILE: V LAB// VA Health Summary 
     1   VA HEALTH SUMMARY COMPONENT      (204 entries) 
     2   VA HEALTH SUMMARY OBJECTS        (15 entries) 
     3   VA HEALTH SUMMARY TYPE           (15 entries) 
     4   VA HEALTH SUMMARY USER PREFERENCE    (1 entry) 
CHOOSE 1-4: 3  VA HEALTH SUMMARY TYPE     (15 entries) 
Select VA HEALTH SUMMARY TYPE NAME: Hypertension Control 
ANOTHER ONE: 
STANDARD CAPTIONED OUTPUT? Yes//   (Yes) 
Include COMPUTED fields:  (N/Y/R/B): NO// BOTH Computed Fields and Record 
Number 
 (IEN) 
 
NUMBER: 53 <<< IEN                   NAME: HYPERTENSION CONTROL 
  OWNER: RICHARDS,SUSAN P 
SUMMARY ORDER: 5                        COMPONENT NAME: MEASUREMENT PANELS 
  OCCURRENCE LIMIT: 3                   HEADER NAME: Measurement Panels 
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SELECTION ITEM: Hypertension Measurements 
SUMMARY ORDER: 10                       COMPONENT NAME: FLOWSHEET 
  OCCURRENCE LIMIT: 3                   HEADER NAME: Flowsheet 
SELECTION ITEM: Hypertension Labs 
  TIMESTAMP: 63641,51300 

2. Add a Health Summary Report button to the Toolbar in Design Mode 

 
Figure 7-8: Add an Object dialog 

 
Figure 7-9: Health Summary Report 
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Figure 7-10: Properties for Health Summary Report dialog 

3. Set the appropriate value for each Property 

• CAPTION is the name to be displayed on the button. 

• Format for the REPORT field is: 
– IHS^IEN of report (for IHS Health Summaries) 
– 1^IEN of report (for VA Health Summaries) 

4. Click OK. 

 
Figure 7-11: EHR ribbon 
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Figure 7-12: Hypertension Control Health Summary 
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8.0 Deploy Million Hearts Clinical Reminders 
There are two reminders: 

• IHS-MH Hypertension Control 2015 is designed to be deployed in the EHR and 
includes a reminder dialog. 

• IHS-MH Hypertension Recall 2015 is a reminder written specifically to create a 
recall list of patients who have essential hypertension (Section 10.0). 

8.1 Install Reminders from the Reminder Exchange 

8.1.1 IHS-MH-Hypertension Control 2015 
Please refer to the PXRM 2.0 patch documentation pxrm0200.5.pdf. The PXRM v2.0 
managers manual is available on the RPMS Clinical Document Repository under VA 
Clinical Reminders. Select the user link under manuals: 

http://www.ihs.gov/RPMS/index.cfm?module=Applications&option=View&AC_
ID=0 

 
Figure 8-1: Reminder Exchange Install Reminder 

1. Use the IFE (install exchange file entry) option to install reminder. 

2. At the “Select Action” prompt, select Next Screen// 112. 

http://www.ihs.gov/RPMS/index.cfm?module=Applications&option=View&AC_ID=0
http://www.ihs.gov/RPMS/index.cfm?module=Applications&option=View&AC_ID=0
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Figure 8-2: Reminder Exchange Install all option 

Use IA (install all components option) 

Select Action: Next Screen// ia  Install all Components 

The install process is semi-automated. The system checks to see if the component is 
on RPMS and if the one on the system is identical. If it is, it will skip. If it is missing 
or not identical, it will stop and prompt for the next action. Most of the time you will 
accept the defaults. 

REMINDER TAXONOMY entry named IHS-END STAGE RENAL DISEASE already exists 
and the packed component is identical, skipping. 
 
REMINDER TAXONOMY entry named TEST-ESSENTIAL HYPERTENSION already exists 
and the packed component is identical, skipping. 
 
REMINDER TERM entry named IHS-HIGH BP 2007 already exists and the packed 
component is identical, skipping. 
 
REMINDER TERM entry named IHS-CONTROLLED BP 2015 already exists and the 
packed component is identical, skipping. 

When completed, you will see another screen and be asked to install the dialog. 
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Figure 8-3: Reminder Exchange Install Dialog 

Again choose IA (install all). The following components do not automatically import. 

 Quick Orders: either make new ones with identical name or have ready 
your local quick orders to replace them on install 
LRZ BMP TODAY 
LRZ LIPIDS 
GMRCZ FITNESS PROGRAM 
GMRCZ NUTRITION 
GMRCZ TOBACCO CESSATION 
GMRCZ SOCIAL SERVICES 
 TIU Objects: you will need to make objects if you have not done so 
already 
Hypertension Control VA Health Summary for TIU object 
 
Select Action: Next Screen// IA 
 
Install reminder dialog and all components with no further changes: 
Y//<enter> 

Similar to the Reminder Installation, the system checks your RPMS to see if there is 
each element and if found if it is identical. If not, it will stop and prompt you for the 
next action. 

Install reminder dialog and all components with no further changes: Y// ES 
REMINDER DIALOG entry named OR HTN SMOKING CESSATION already exists and the 
packed component is identical, skipping. 
 
REMINDER DIALOG entry named OR HTN SOCIAL SERVICES already exists and the 
packed component is identical, skipping. 
 
REMINDER DIALOG entry named OR HTN PHN already exists and the packed 
component is identical, skipping. 
 
REMINDER DIALOG entry named OR HTN NUTRITION already exists and the 
packed component is identical, skipping. 
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REMINDER DIALOG entry named OR HTN HOME HEALTH already exists and the 
packed component is identical, skipping. 
 
REMINDER DIALOG entry named OR HTN EXERCISE already exists and the 
packed component is identical, skipping. 

If you do not have the identical quick orders on your system, it will prompt you to 
enter your local quick orders. 

Once the dialog instillation is complete, you will need to Enable the dialog. They are 
disabled on import from the exchange. 

Navigate to the Reminder Dialog menus. BEH>REM>DLG>DLG 

 
Figure 8-4: Reminder Dialog menu 

This is the Dialog List in the Reminder View. The name of the Reminder Definition 
is on the left and the linked dialog if present is on the right. To enable the dialog you 
will select the item number – in this example 167. 

Select Item: Next Screen//167 
 
At the next screen you will select 1 to edit the dialog. 
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Figure 8-5: Dialog Selection List 

Select Item: Quit//1 

The next screen is the Dialog Edit List and you will Edit the dialog 

 
Figure 8-6: Dialog Edit List 

Select Next Item: Next Screen//ED Edit/Delete Dialog 
NAME: IHS-MH HYPERTENSION CONTROL 2015 Replace 
DIASBLE: Disabled//@ <<< this removes the text. Any text or spaces here 
will disable the dialog 
  SURE YOU WANT TO DELETE? Y (Yes) 
CLASS: LOCAL// ^ <<< you can just jump out from here 
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8.1.2 IHS-MH Hypertension Recall 2015 
Repeat the installation process in Section 8.1.1. This reminder will not have a dialog. 
This reminder is only to be used to generate Reminder Reports and not deployed in 
the EHR GUI. 

8.2 Configure Reminder and Dialog in EHR 
To configure reminders in the GUI, set the PXRM EHR CONFIGURATION 
parameter. 

BEH → REM→ PAR →    CFG –  Allow EHR Configuration in GUI 
     100 User          USR    [choose from NEW PERSON] 
     200 Class         CLS    [choose from USR CLASS] 
     300 Division      DIV    [DEMO HOSPITAL] 
     400 System        SYS    [DEMO.MEDSPHERE.COM] 
 
Enter selection: 100  User   NEW PERSON ←set for user or CAC class 
Select NEW PERSON NAME: user,demo  USER,DEMO 
-- Setting Can configure reminders within GUI  for User: USER,DEMO --- 
Can configure reminders within GUI: YES// 

1. Log on to EHR. 

2. Select a patient. 

3. Click the reminder icon. The Available Reminders dialog (Figure 8-7) is 
displayed. 

 
Figure 8-7: Available Reminders dialog 

4. Select the Action menu. 

5. Select Edit Cover Sheet Reminder List. The Clinical Reminders and 
Reminder Categories Displayed on Cover Sheet dialog (Figure 8-8) displays. 
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Figure 8-8: Clinical Reminders and Reminder Categories Displayed on Cover Sheet 

dialog 

• The top section shows how the reminders are set up. 

• The middle section allows the CAC to assign reminders by the different 
groups. 

• The left lower area is the list of available reminders. 

• The right lower area is the assignment for the chosen level. 
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Figure 8-9: Clinical Reminders and Reminder Categories Displayed on Cover Sheet 

dialog 

6. Select System to deploy to all users (test this at the User level first). 

7. Select to highlight the Hypertension Control (MH) reminder. 

8. Use the right arrow to move it to the System Level Reminders. 

9. Click Apply to save. 

10. Click OK to exit. 

11. Select a patient with Hypertension. 

12. Click the Reminders icon on the toolbar and if the reminder is due, it will display 
on the Available Reminders dialog (Figure 8-10) and on the notes tab (Figure 
8-11). 
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Figure 8-10: Available Reminders dialog 

 
Figure 8-11: Reminders pane on the Notes tab 
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Figure 8-12: Reminder Resolution dialog 
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Figure 8-13: Reminder Resolution dialog; display meds 
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Figure 8-14: Reminder Resolution dialog; note start 
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Figure 8-15: Reminder Dialog Template; enter interventions 
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Figure 8-16: Unresolved template fields from processed Reminders dialog 

 

Figure 8-17: Order a Lab Test dialog 
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Figure 8-18: Resulting TIU note 

 
Figure 8-19: Stored Orders 

 
Figure 8-20: Education Topics 
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9.0 Configure IPL Care Planning 
Sites may configure IPL care planning to use TIU templates. 

9.1 Import TIU Templates 
Importing template are quick and simple using either the sample TIU templates 
provided or ones received from another facility. Template fields import, but TIU 
objects do not. Either create TIU objects of the identical name, or replace the TIU 
objects with local ones using the Template editor. 

To use TIU templates for IPL Care Planning, they must be in SHARED templates and 
may not be in a Template Folder. We recommend using a naming convention to 
easily identify these types of templates: 

• IPL Goal Diabetes 

• IPL Plan Diabetes 

• IPL Instructions Diabetes 

1. Place template files on the workstation’s desktop. 

2. Navigate to the Notes tab (Figure 9-1). 

 
Figure 9-1: Options menu accessing the shared template editor 

3. Select the Options menu. 

4. Select Edit Shared Templates to open the Template Editor dialog (Figure 9-2). 
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Figure 9-2: Template Editor dialog with Tools menu displayed. 

5. Click in the Shared Templates pane. 

6. Select the Tools menu. 

7. Select Import Template. The Template File Selection dialog (Figure 9-3) is 
displayed. 

 
Figure 9-3: Template File Selection dialog 

8. Select a TXML file and click Open. The file is imported into the shared template 
folder. 
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Figure 9-4: Template Editor after import 

9. Repeat for the remaining template files. Successfully imported files will be listed 
in the Shared Templates pane. 

10. Click APPLY. 

11. Click OK. 

9.2 Parameter Setup 
1. Set the three parameters to make the templates available on the IPL and POV care 

planning dialogs as shown in the following sequence: 

XX     General Parameter Tools ... 
Select General Parameter Tools Option: ep  Edit Parameter Values 
                         --- Edit Parameter Values --- 
 
Select PARAMETER DEFINITION NAME:    BGO IPL CARE TEMPLATE   List of TIU 
Templates for IPL Care Notes 
 
BGO IPL CARE TEMPLATE may be set for the following: 
 
     100 User          USR    [choose from NEW PERSON] 
     700 Division      DIV    [2011 DEMO HOSPITAL] 
     800 System        SYS    [2011 DEMO-HO.ABQ.IHS.GOV] 
 
 
Enter selection: 800  System   2011 DEMO-HO.ABQ.IHS.GOV 
 
--- Setting BGO IPL CARE TEMPLATE  for System: 2011 DEMO-HO.ABQ.IHS.GOV --- 
Select Sequence: 5 
Are you adding 5 as a new Sequence? Yes// y  YES 
 
Sequence: 5//    5 
Template Name: IPL Goal HTN MH 
Select Sequence: 
 
Repeat this for: 
  Parameter:  BGO IPL CARE TEMPLATE 
Template: IPL Plan HTN MH template 
 
Parameter: BGO IPL VISIT TEMPLATE 
Template: IPL Instruction HTN MH template 

2. Log off then log on to RPMS. 
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9.3 Use Care Plan Templates 
Templates can be accessed from either of the following: 

• The Add/Edit Problem dialog if Use as POV is checked. 

• The POV dialog. 

 
Figure 9-5: Edit Problem dialog 

1. Access the Care Planning dialog: 

a. Select Use as POV on the Edit Problem dialog. 

b. Click Add Visit Instruction/Care Plans/Goal Activities. The Care Planning 
dialog (Figure 9-6) is displayed. 
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Figure 9-6: Care Planning dialog, template selection 

2. Click the template icon of any of the care plan sections to set up the template 
selections in the parameters display. 

 
Figure 9-7: Template dialog 
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Care planning templates may also be launched from the POV selection dialog: 

 
Figure 9-8: Care planning dialog selected from POV dialog 

1. Right click Add. 

2. Click the template icon. 

9.4 Sample IPL templates 

 
Figure 9-9: IPL Goal HTN MH template 



EHR Optimization for Million Hearts Blood Pressure Management 

User Guide Configure IPL Care Planning 
November 2015 

55 

 
Figure 9-10: IPL Plan HTN MH template 

 
Figure 9-11: Plan template - Lifestyle mod section 
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Figure 9-12: Plan template - medication and follow up sections 

 
Figure 9-13: IPL Instructions HTN MH template 
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10.0 Population Health 

10.1 Reminder Reports 
IHS-MH Hypertension Recall 2015 is a reminder written specifically to create a recall 
list of patients who have essential hypertension and either of the following is true: 

• Their last BP was controlled but was last done more than one year ago. 

• Their last BP was not controlled and was last done over one month ago. 
From the RPMS-Master Configuration menu BEH>REM>RPT 

   DUE    Reminders Due Report 
   REV    Review Date Report 
   TPL    User Report Templates 
   USR    Reminders Due Report (User) 

Reminder reports may be run for a facility, for a clinic, or by provider. 

10.2 iCare 

10.2.1 Reminders in iCare 
iCare will automatically pick up the new IHS-MH Hypertension Recall 2015 when it 
is installed and activated in EHR. The iCare nightly background job always searches 
for new reminders and sets them up to be accessed in iCare. 

The return value of the EHR reminder is DUE NOW, which translates to the current 
date when viewed in iCare. This means that for Reminder Notifications, any patient 
with a DUE NOW value is considered to be overdue. 

Other reminders associated with the Million Hearts campaign can be viewed by 
setting up a specific Million Hearts reminder template. See Section 10.2.3 for 
instructions to create a Public Template that can be applied by all users. The reminder 
template can show the new reminder as well as other reminders that could be related 
to the Million Hearts initiative. 

Reminder Notifications Panel 
Once the reminder has been activated and reminder data calculated, a panel of 
patients can be created with overdue Million Hearts Hypertension Control. 
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Figure 10-1: iCare Panel Definition 

Results can be sorted and filtered by Communication Preference, Reminder Due, etc. 
making it easier to identify patients who need work on controlling their blood 
pressure. Sending patient notifications via iCare counts towards the MU Stage 2 
Patient Reminders measure. 

 
Figure 10-2: Hypertension Panel display 

10.2.2 CRS in iCare 
When CRS Version 15.1 is released, iCare will recognize the CRS Measure - MH: 
Controlling High BP. It is available from the Main View, Panel View and Patient 
View. 
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A specific Million Hearts Natl Measures template may be set up to view other CRS 
measures associated with the Million Hearts campaign. The template can show LDL 
assessed (there are several measures for LDL assessed), Tobacco Screening and 
Cessation Counseling, and other measures that may be significant to the Million 
Hearts initiative. See Section 10.2.3 for instructions to create a Public Template that 
can be applied by all users. 

10.2.3 Template Management 
The templates mentioned previously can be created by one person in iCare and 
uploaded to Public Templates for use by anyone. 

10.2.3.1 Reminders Template 
1. Select Template Management from the Tools menu. 

2. Click Add; the Add Template dialog (Figure 10-3) is displayed. 

 
Figure 10-3: Add Template dialog 

3. Select Reminders from the Layout field. 

4. Type a unique Template Name in the field. 

5. Click Add; the Reminders Template dialog (Figure 10-4) is displayed. 
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Figure 10-4: Reminders Template 

6. Select the specific reminders to include as part of the Million Hearts initiative 
from the Available Columns pane. 

7. Click Add to move the reminders to the Display Columns pane. 

8. To change the order of the columns: 

a. Select a reminder in the Display Columns pane. 

b. Click Up or Down. 
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Figure 10-5: Template Management Upload 

9. Click Upload to create a new template and make it available for other users. 

10. Select an existing panel of patients or create a new panel of patients based on any 
desired criteria. 

 
Figure 10-6: Modify Layout 

11. Click Modify. 

12. Select the Layouts tab. 

13. Click Edit to change the Layout in Use from Reminders Default to the newly 
created template. The Reminders Layout dialog (Figure 10-7) is displayed. 
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Figure 10-7: Reminders Layout dialog 

14. Open the panel and select the Reminders tab (Figure 10-8) to view the patients 
and their respective reminder information. 

 
Figure 10-8: Reminders tab 

Note: Remember after enabling the new EHR reminder, IHS-MH 
Hypertension Recall 2015, the iCare nightly job will need 
to update the system with the new reminder. You may also 
need to ask your RPMS system manager to set up the BQI 
UPDATE ALL REMINDERS task to run overnight in 
order to get data for the new reminder. The value of NDA 
may mean that the patient does not have reminders 
calculated yet. The value of N/A means the patient did not 
meet the criteria for the reminder. 
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10.2.3.2 National Measures Template 
1. Select Template Management from the Tools menu. 

2. Click Add; the Add Template dialog (Figure 10-9) is displayed. 

 
Figure 10-9: Add Template dialog 

3. From the Layout list, select Natl Measures. 

4. Type a unique Template Name in the field. 

5. Click Add: the Natl Measures Template dialog (Figure 10-10) is displayed. 

 
Figure 10-10: National Measures Template dialog 

Note: If CRS Version 15.1 is not installed, you will not have the 
measure, MH: Controlling High BP in your system. Look 
over and select other measures that may help with the 
Million Hearts initiative. 
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Figure 10-11: Edit National Measures Template 

6. Select the specific reminders to include as part of the Million Hearts initiative 
from the Available Columns pane. 

7. Click Add to move the reminders to the Display Columns pane. 

8. To change the order of the columns: 

a. Select a reminder in the Display Columns pane. 

b. Click Up or Down. 
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Appendix A:  Sample Layouts 

 
Figure A-1: Problem and visit data using Tree Node 

 
Figure A-2: Problem and visit data using Tabbed Notebook 

 
Figure A-3: Hypertension tab with web sites and health summary buttons 
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Figure A-4: Diabetes tab with websites and health summaries 

 
Figure A-5: Resources tab 
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Appendix B:  Sample Health Summaries 

B.1 Best Practice Prompts 
Consider exposing the PCC Best Practice Prompts in a report. This provides clinical 
guidance based on iCare CVD tags. Please see the IHS PCC Suite (BJPC) 
documentation, PCC Health Summary User Manual Appendix B for logic: 
http://www.ihs.gov/RPMS/index.cfm?module=Applications&option=View&AC_ID=0 

 
Figure B-1: Health Summary Button with CVD Best Practice Prompts 

http://www.ihs.gov/RPMS/index.cfm?module=Applications&option=View&AC_ID=0
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B.2 Diabetes Summary 

 
Figure B-2: Health Summary Button with Diabetes Summary 



EHR Optimization for Million Hearts Blood Pressure Management 

User Guide Clinical Reminder Logic 
November 2015 

69 

Appendix C:  Clinical Reminder Logic 

C.1 IHS-MH Hypertension Control 2015 
    --------------------------------------------------------- 
    REMINDER APPLICABLE if patient has hypertension and not end stage renal 
    disease. 
    REMINDER DUE if: 
      Blood pressure is not controlled (SBP>139 OR DBP >89) 
        OR 
      Blood pressure is controlled (SBP <140 AND DBP<90) but no BP  
      documented in past year. 
    ---------------------------------------------------------- 
    ================================================ 
    Bibliographic citation:  Million Hearts, IHS Hypertension Protocol 2015 
    Developer: IHS Office of Information Technology Funding Source:  Indian 
    Health Service Release:  2015 
    ================================================ 
Baseline Frequency: 
 
      Do In Advance Time Frame:  Wait until actually DUE 
                  Sex Specific: 
                 Ignore on N/A: 
       Frequency for Age Range:  1 year for all ages 
                    Match Text: 
                 No Match Text: 
 
Findings: 
 
  ---- Begin: IHS-ESSENTIAL HYPERTENSION  (FI(1)=RT(100)) ----------------- 
                  Finding Type: REMINDER TERM 
   Use in Patient Cohort Logic: AND 
 
                         Mapped Findings: 
                     Mapped Finding Item: TX.IHS-ESSENTIAL HYPERTENSION 
 
                     Mapped Finding Item: CF.IHS-SNOMED 
              Computed Finding Parameter: PXRM ESSENTIAL HYPERTENSION 
 
  ---- End: IHS-ESSENTIAL HYPERTENSION ------------------------------------ 
 
  ---- Begin: IHS-CONTROLLED BP 2015  (FI(2)=RT(98)) ---------------------- 
                  Finding Type: REMINDER TERM 
       Use in Resolution Logic: OR 
              Occurrence Count: 1 
 
                         Mapped Findings: 
                     Mapped Finding Item: MT.BP 
                               Condition: I 
($P(V,"/",1)<140)&($P(V,"/",2)<90) 
 
  ---- End: IHS-CONTROLLED BP 2015 ---------------------------------------- 
 
  ---- Begin: IHS-ESRD 2015  (FI(3)=RT(99)) ------------------------------- 
                  Finding Type: REMINDER TERM 
   Use in Patient Cohort Logic: AND NOT 
 
                         Mapped Findings: 
                     Mapped Finding Item: TX.IHS-END STAGE RENAL DISEASE 
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  ---- End: IHS-ESRD 2015 ------------------------------------------------- 
 
    ---- Begin: IHS-HIGH BP 2007  (FI(4)=RT(12)) -------------------------- 
                  Finding Type: REMINDER TERM 
 
                         Mapped Findings: 
                     Mapped Finding Item: MT.BP 
                            Condition: I ($P(V,"/",1)>139)!($P(V,"/",2)>89) 
 
  ---- End: IHS-HIGH BP 2007 ---------------------------------------------- 

C.2 IHS-MH Hypertension Recall 2015 
(Reminder Report) 

Baseline Frequency: 
 
      Do In Advance Time Frame:  Wait until actually DUE 
                  Sex Specific: 
                 Ignore on N/A: 
       Frequency for Age Range:  1 year for all ages 
                    Match Text: 
                 No Match Text: 
 
Findings: 
 
  ---- Begin: IHS-HYPERTENSION 2014  (FI(1)=RT(39)) ----------------------- 
                  Finding Type: REMINDER TERM 
   Use in Patient Cohort Logic: AND 
 
                         Mapped Findings: 
 
                     Mapped Finding Item: TX.IHS-HYPERTENSION 2007 
                     Beginning Date/Time: T-3Y 
 
                     Mapped Finding Item: CF.IHS-SNOMED 
                     Beginning Date/Time: T-3Y 
              Computed Finding Parameter: PXRM HYPERTENSION 
 
  ---- End: IHS-HYPERTENSION 2014 ----------------------------------------- 
 
  ---- Begin: IHS-CONTROLLED BP 2015  (FI(2)=RT(98)) ---------------------- 
                  Finding Type: REMINDER TERM 
       Use in Resolution Logic: OR 
 
                         Mapped Findings: 
                     Mapped Finding Item: MT.BP 
                               Condition: I 
($P(V,"/",1)<140)&($P(V,"/",2)<90) 
  ---- End: IHS-CONTROLLED BP 2015 --------------------------------------- 

C.3 Additional relevant Clinical Reminders 
• IHS-Lipid Female 2014 
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• IHS-Lipid Male 2014 

• IHS-CVD 2013 

• IHS-Tobacco Screen 2013 
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Appendix D:  Controlling High Blood Pressure – 
Million Hearts 

(CRS Measure) 

Owner and Contact 
Dr. Dena Wilson, Chris Lamer, PharmD, and Mark Veazie 

National Reporting 
NATIONAL (included in National GPRA/GPRAMA Report; reported to OMB and 
Congress) 

Denominators 
1. GPRA: Million Hearts (NQF 0018): User Population patients ages 18 through 85 
years diagnosed with hypertension and no documented history of ESRD or current 
diagnosis of pregnancy. 

Numerators 
1. GPRA: Million Hearts (NQF 0018): Patients with BP less than (<) 140/90, i.e., the 
systolic value is less than (<) 140 AND the diastolic value is less than (<) 90. 

Definitions Age 
Age of the patient is calculated at end of the Report period. 

Hypertension 

Diagnosis (POV or Problem List entry where the status is not Inactive or Deleted) 
ICD-9: 401.*; ICD-10: I10 ever through the first 6 months of the Report Period, and 
at least 1 hypertension POV during the report period. 

ESRD 
Any of the following ever: 

• CPT 36145 (old code), 36147, 36800, 36810, 36815, 36818, 36819, 36820, 
36821, 36831 through 36833, 50300, 50320, 50340, 50360, 50365, 50370, 50380, 
90918 through 90925 (old codes), 90935, 90937, 90939 (old code), 90940, 90945, 
90947, 90951 through 90970, 90989, 90993, 90997, 90999, 99512, 3066F, 
G0257, G0308 through G0327 (old codes), G0392 (old code), G0393 (old code), 
G9231, S2065, S9339 

• POV ICD-9: 585.6, V45.1 (old code), V45.11 V45.12, V56.*; ICD-10: N18.6, 
Z48.22, Z49.*, Z91.15, Z94.0, Z99.2 

• Procedure ICD-9: 38.95, 39.27, 39.42, 39.43, 39.53, 39.93 through 39.95, 54.98, 
55.6* 
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Pregnancy Definition 
At least two visits during the Report Period with POV or Problem diagnosis: 

• ICD- 9: 640.*3, 641.*3, 642.*3, 643.*3, 644.*3, 645.*3, 646.*3, 647.*3, 648.*3, 
649.*3, 651.*3, 652.*3, 653.*3, 654.*3, 655.*3, 656.*3, 657.*3, 658.*3, 659.*3, 
660.*3, 661.*3, 662.*3, 663.*3, 665.*3, 668.*3, 669.*3, 671.*3, 673.*3, 674.*3, 
675.*3, 676.*3, 678.*3, 679.*3, V22.0 through V23.9, V28.81, V28.82, V28.89, 
V72.42, V89.01 through V89.09; ICD-10: O09.00 through O10.02, O10.111 
through O10.12, O10.211 through O10.22, O10.311 through O10.32, O10.411 
through O10.42, O10.911 through O10.92, O11.1 through O15.1, O15.9 
through O24.02, O24.111 through O24.12, O24.311 through O24.32, O24.41*, 
O24.811 through O24.82, O24.911 through O24.92, O25.10 through O25.2, 
O26.00 through O26.62, O26.711 through O26.72, O26.811 through O26.93, 
O29.011 through O30.93, O31.* through O48.*, O60.0*, O61.* through O66.*, 
O68, O69.*, O71.00 through O71.1, O71.89, O71.9, O74.0 through O75.81, 
O75.89, O75.9, O76 through O77.*, O88.011 through O88.02, O88.111 through 
O88.12, O88.211 through O88.22, O88.311 through O88.32, O88.811 through 
O88.82, O90.3, O91.011 through O91.019, O91.111 through O91.119, O91.211 
through O91.219, O92.011 through O92.019, O92.20, O92.29, O98.011 through 
O98.02, O98.111 through O98.12, O98.211 through O98.22, O98.311 through 
O98.32, O98.411 through O98.42, O98.511 through O98.52, O98.611 through 
O98.62, O98.711 through O98.72, O98.811 through O98.82, O98.911 through 
O98.92, O99.011 through O99.02, O99.111 through O99.12, O99.210 through 
O99.214, O99.280 through O99.284, O99.310 through O99.314, O99.320 through 
O99.324, O99.330 through O99.334, O99.340 through O99.344, O99.350 through 
O99.354, O99.411 through O99.42, O99.511 through O99.52, O99.611 through 
O99.62, O99.711 through O99.72, O99.810, O99.814, O99.820, O99.824, 
O99.830, O99.834, O99.840 through O99.844, O99.89, O9A.111 through 
O9A.12, O9A.211 through O9A.22, O9A.311 through O9A.32, O9A.411 through 
O9A.42, O9A.511 through O9A.52, Z03.7*, Z32.01, Z33.1, Z34.*, Z36, 

where the primary provider is not a CHR (Provider code 53). Pharmacy-only visits 
(clinic code 39) will not count toward these two visits. If the patient has more than 
two pregnancy- related visits during the Report Period, CRS will use the first two 
visits in the Report Period. The patient must not have a documented miscarriage or 
abortion occurring after the second pregnancy-related visit. 

• Miscarriage definition: 

− –  POV ICD-9: 630, 631, 632, 633*, 634*; ICD-10: O03.9 
− –  CPT 59812, 59820, 59821, 59830 

• Abortion definition: 

− –  POV ICD-9: 635*, 636* 637*; ICD-10: O00.* through O03.89, O04.*, 
Z33.2 
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− –  CPT 59100, 59120, 59130, 59136, 59150, 59151, 59840, 59841, 59850, 
59851, 59852, 59855, 59856, 59857, S2260 through S2267, 

− –  Procedure ICD-9: 69.01, 69.51, 74.91, 96.49; ICD-10: 0WHR73Z, 
0WHR7YZ, 10A0***, 3E1K78Z, 3E1K88Z 

BP Values 
Exclusions: When calculating all BPs, the following visits will be excluded: 

• Service Category H (Hospitalization), I (In Hospital), S (Day Surgery), or O 
(Observation) 

• Clinic code 23 (Surgical), 30 (ER), 44 (Day Surgery), C1 (Neurosurgery), or D4 
(Anesthesiology) 

CRS uses the last Blood Pressure documented during the Report Period. 

GPRA 2015 Description 
During FY 2015, achieve the target rate of 59.5% for the proportion of patients with 
BP less than (<) 140/90. 

Patient List 
List of patients with hypertension and BP value, if any. 
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Appendix E:  IHS Mobile Health References 
1. Launch the web browser on the mobile device. 

2. Type the following address in the browser: 
http://www.ihs.gov/MedicalPrograms/Diabetes/index.cfm?module=toolsDTTreat
mentAlgorithm and press Enter. 

3. When the ihs.gov website opens it should display the Division of Diabetes 
Treatment and Prevention mobile-friendly website (Figure E-1). 

 
Figure E-1: Division of Diabetes Treatment and Prevention mobile-friendly website 

http://www.ihs.gov/MedicalPrograms/Diabetes/index.cfm?module=toolsDTTreatmentAlgorithm
http://www.ihs.gov/MedicalPrograms/Diabetes/index.cfm?module=toolsDTTreatmentAlgorithm
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4. At the bottom of the screen click the Menu button (appears as a blue square with 
an up arrow). The menu (Figure E-2) is displayed. 

 
Figure E-2: Menu 

5. Click Add to Home Screen (appears as a plus sign). The Add to Home page 
(Figure E-3) is displayed. 
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Figure E-3: Add to Home page 

6. Type Algorithms in the input field 

7. Click Add (located at the top right hand corner of the screen). The device’s home 
screen redisplays (Figure E-4) with a new icon. 
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Figure E-4: Mobile device home screen 

8. Click Algorithms to launch the mobile-friendly website. 
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Figure E-5: Links page 

9. To review the hypertension guidelines, click Provider Mobile Site. The 
Disclamer page (Figure E-6) displays. 



EHR Optimization for Million Hearts Blood Pressure Management 

User Guide IHS Mobile Health References 
November 2015 

80 

 
Figure E-6: Disclaimer page 

10. To view the algorithm, accept the disclaimer by clicking Continue. The Provider 
Resources page (Figure E-7) is displayed. 
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Figure E-7: Provider Resources page 

 
11. Click Treatment Algorithms. The Algorithm page (Figure E-8) is displayed. 
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Figure E-8: Diabetes Treatment Algorithms page 

12. Select Hypertension to display the Hypertension Algorithm. Do any of the 
following: 

• Click the Undo button (appears as an arrow curved to the left) to return to the 
Provider Resources page. 

• Click Over to display the back side of the Hypertension Algorithm. 
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Figure E-9: Hypertension Management page 

• Use your finger to scroll up and down through the algorithm. 

• Use two fingers to zoom the algorithm. 
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Figure E-10: Hypertension Management page 
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Figure E-11: Hypertension Management page 

13. Click Back to return to the front of the Hypertension Algorithm: 
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Acronym List 

Acronym Meaning 
CAC Clinical Application Coordinator 

EHR Electronic Health Record 

IEN Internal Entry Number 

IHS Indian Health Service 

IPL Integrated Problem List 

RPMS Resource and Patient Management System 

TIU Text Integration Utility 

VA US Department of Veterans Affairs 
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Contact Information 

If you have any questions or comments regarding this distribution, please contact the 
OIT Help Desk (IHS). 

Phone: (888) 830-7280 (toll free) 

Web: http://www.ihs.gov/helpdesk/ 

Email: support@ihs.gov 

http://www.ihs.gov/helpdesk/
mailto:support@ihs.gov
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